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Operator Login 

To login in to the CooVox series IPPBX operator web portal, please ask the system administrator for the IPPBX 

system web interface URL and the operator user credentials. 

Copy the URL you got from the administrator to your web browser address bar and press enter, due to the 

certificate issue, the web browser will display a warning screen, take Google Chrome for instance. 

 

It will warn you that “Your connection is not private”. Please click on “Advanced” and click on “Proceed to 

xx.xx.xx.xx (Unsafe)”, then you will enter the login screen. 

 

Please enter the credentials provided by the administrator, once done, click on “Login” to login in the operator 

user web portal. 
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Dashboard 

Path: Status->Dashboard 

Dashboard is mainly for users to know some hardware or software information of PBX. You may see them here on 

this screen，such as CPU utilization, Memory occupancy, System Info and Calls in Progress and so on. 

On the Call in Progress, the horizontal axis represents the call time and the vertical axis represents the current 

number of calls. We can see there is no call in progress on the picture below. 

 

Switchboard 

Extensions  

Path: Status->Switchboard->Extensions 

Extensions can set up by Phone provision or manual configuration. If you configure an extension successfully, you 

may see its status like shown below on this page. Five status are available, Idle, Ringing, Busy, Offline, DND. You 

could distinguish all status by different colors. 
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For the analog extensions, as long as there are no calls going on, their status will always be Idle, you'll just need to 

attach the analog phones to the FXS interface of the IPPBX system, and the phones will be ready for phone calls. 

For the IP extensions, if they are registered there will be IP addresses displayed to indicate where the register is 

coming from. For other extension status please check the examples on the top of the extension list.  

Trunks 

Path: Status->Switchboard->Trunks 

The information of VoIP Trunks or Analog Lines can be seen on this page.  

You can make outbound phone calls after configuring a VoIP trunk. Only are you allowed to check the status of  

VoIP trunks, but setting up a VoIP trunk is not allowed. 

Analog Lines including FXO interface and FXS interface. The FXO interface is connected with telephone lines and 

the FXS interface is connected with analog extension directly. You could see their status on the Trunks page as 

shown below. 
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Extensions 

Path: Telephony -> Extensions 

Extensions and departments should have been created by the system administrator user already. As operator user, 

you may also manage extensions and departments here on this screen.  

Departments 

Path: Telephony -> Extensions -> Departments 

Department concept is new on CooVox series IPPBX v3.0 software. Extensions are grouped by your company’s 

actual organizational structure.  

A department is equal to a Pick-up group. 

A department is equal to a Call groups (Ring Group). 

 

You should see all your existing departments and extensions here created by the administrator user. 

 

If you wish to create a new department, please click on the Add button. Specify the department name and select 

member extensions then submit. 

If you wish to modify department settings, please click on the  button, or click on the  button to delete a 

department. 
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 You may change the department name from the Department Name textbox. 

 Ring Strategy defines how to ring the department member extensions on incoming calls. 

 Destination if no answer defines where to handle the incoming call when nobody answers it. 

 Remove extensions from this department by clicking on the “X” button of each extension number. 

 Add new extensions by clicking on the “ ” button to show all available extensions. 
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IP Extensions 

Path: Telephony -> Extensions -> IP Extensions 

IP extensions are user extensions that can be registered on various SIP/IAX2 endpoints, including desktop IP 

phones, softphone for Windows/Android phones/iPhones/Linux and some other endpoints that support SIP/IAX2 

protocol. 

 

To check or modify the extension properties please click the  button. 

 

 User Name: Alias of this extension which can be the name of the extension user. 

 Password: The password used for the phones to register or by the extension user to sign in the extension 

web portal. This can be set manually or can be generated by the IPPBX system. Auto generated password 

consists of numbers, letters and special characters. 

 Email: Email address of this extension user. 

 Outbound CID: Choose a number to show to the external called party. This feature only works with E1/T1, 

BRI and SIP trunks if the telco/ITSP (Internet Telephony Service Provider) allows this number to be passed. 

 Music On Hold: When the user holds a call the caller will listen to music, the music the caller listens to is set 

here. 

 Mobile Number: The mobile phone number of the extension user. 

 Department: The department this extension user belongs to. 

 Dial Permission: Defines which type of numbers the extension can dial. 

 Language: If the extension user is not a native speaker of the system default language, you may set a 

different language for this user. 
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 Voicemail: Voicemail box could be enabled or disabled for this user. 

 Voicemail Password: The password used to access voicemail by voicemail feature codes. 

 Remote Extension: If you want the extension can be used out of the LAN this option needs to be enabled. 

Before doing this please ensure the extension uses strong password. 

 Simultaneous Register Count: The extensions could be registered on up to 5 different SIP endpoints at the 

same time, by default the value is 2. When there are already 2 registers the 3rd register will be responded 

with a 403 error. 

 Video Call: You may enable/disable video call support of this extension. 

 Video Codecs: Supported video codecs are H.261, H.263, H.263+, H.264, VP8. 

 Web Portal: If enabled, users can use their extension number and password to login to the IPPBX system web 

GUI. 

 Call Recording: This is an automated recording option, you may choose to automatically record the inbound, 

outbound or both inbound and outbound calls from/to this extension.  

 Call Spy: Call Spy feature allows the phone calls of this extension to be monitored from other extensions, 

please refer to Call Spy Feature Codes for how to monitor phone calls. 

 Register Expiration: Default register expiration time, default value 120 seconds. 
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 Transport Protocol: The transport protocol to be used by SIP signaling. By default it uses UDP protocol, if you 

choose to use TCP or TLS please make sure on the SIP IP phone or softphone uses the same protocol. 

Otherwise you’ll get 403 error on SIP register. 

 DTMF Mode: Defines how the system detects DTMF tones, the default setting is RFC4733, it can be changed 

if necessary. 

 SRTP: Secure Real-time Transport Protocol (SRTP) encrypts the RTP traffic to secure your VoIP phone calls. 

Before enabling this option you need to ensure the SIP end point can also support SRTP. 

 Qualify: The IPPBX system sends a SIP OPTIONS command regularly to check that the device is still online. 

 Audio Codecs: CooVox-V2 IPPBX system supported audio codecs are G.711 (ulaw, alaw), G.722, G.726, G.729, 

GSM, Opus and Speex. The sequence of the audio codecs listed here is the sequence of the audio codecs to 

be used for negotiating the media of a phone call to be established. 

 

If you want more extensions to be created, you may click on  button to add a new extension or click on 

 button to create bulk extensions. 

The extensions’ properties could be set while you are creating them. 
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 Define a Start Extension Number and the number of extensions to be created in the Count field. 

 If you want to associate outbound CID numbers to the extensions, you’ll need to specify the first CID number 

in the Start Outbound CID field and in the CID Calculation field specify the calculating of the following CID 

numbers. Otherwise leave these two blanks blank. 

 In the Password field you may leave it blank so the created extensions will use random passwords or you can 

define a password so the created extensions will share the same password. 

As for other options, you may configure accordingly per your demands. The features/options configured will be 

applied to all newly created extensions. 

 

As you can see there’s a QR code and a Quick Register Code for each of the extensions.  

 

QR code is for quick configuration of the CooCall APP (both Android and iOS versions). It could be viewed and 

scanned from the admin user web interface and operator user web interface. 

The QR code could also be sent to the extension user by Email, you can click on the  button of an extension 

user to send the QR code once at a time or you may select several extensions and click on the  button to 

respectively send QR code of each extension to each of these extension users Email box at a time. 

For more information of how QR code works please refer to the CooCall user manual. 

 

Quick register code is a randomly generate 3-digit code for each of the extension number created in the IPPBX 

system. The quick register code is dedicated for quick configuration of ZYCOO CooFone H81/H81P and H83. For 

more details please refer to Phone Provisioning with Quick Register Code. 
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Analog Extensions 

Path: Telephony -> Extensions -> Analog Extensions 

Analog extensions are generated automatically by the IPPBX system if FXS interfaces are detected. All you have to 

do is attaching analog phones or fax machine to the FXS interface, the analog extensions can be used directly for 

phone calls, no more additional settings required. 

 

The Channel column and Extension column list the FXS interfaces and the corresponding extension numbers. They 

are generated by the IPPBX system which cannot be modified. 

You may click on the  button to change settings when necessary. 

 

 Alias can be defined to identify this analog extension. 

 Department can be selected to add this analog extension to one of the departments. Or could change a 

department it belongs too. 

 Call Recording could be enabled to record Inbound, Outbound or Both direction phone calls if necessary. 

 Language option controls in which language of system voice prompts the extension user will listen to. 

 Dial Permission controls which dial rules the user can use to make phone calls. 

 Input Volume could be used to adjust the input gain of this analog extension. 

 Output Volume could be used to adjust the output gain of this analog extension. 
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Phone Provisioning 

There are 2 different ways to quickly and easily deploy large amount of IP phones on ZYCOO CooVox-V2 series.  

 Quick Register Code 

Quick Register Code is a randomly generate 3-digit number for extension number quick configuration on ZYCOO 

CooFone H81/H81P and H83. 

 PNP(Plug & Play) 

By utilizing PNP, CooVox-V2 series IPPBX system is able to auto discover IP phones connected in the same LAN with 

the IPPBX system. By configuring the discovered IP phones from the IPPBX web UI you may quickly provision large 

amount of IP phones without knowing any of the IP phone’s IP address, or opening any of the IP phone’s web UI. 

 

Notice 

Provisioning IP phones using Quick Register Code and Phone provisioning with PNP cannot work at the same time. 

If you choose to provision the phones by using Quick register code please first go to Telephony -> Extensions -> 

Phone Provisioning page and disable PNP. 

 

 

Phone Provisioning with PNP 

Path: Telephony -> Extensions -> Phone Provisioning 

Enable PNP and click on  button to discover phones that have connected in the same LAN. 

 

The discovered IP phones will be listed here for configurations. Click on the  button to configure a phone. 
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H81/H81P supports 2 SIP lines, usually just one extension for the first line (Line1) would be enough. Further 

configurations are available. 

 

 Call Waiting could be enabled/disabled per the users’ requirements. 

 Greeting Word could be set for displaying on the phone screen is needed. 

 

For H83, there are 4 lines available to be configured. 

 

Set only one extension on Line1 or more on other lines per the users’ requirements. If it’s the operator or the 

secretary's phone BLF might also need to be configured. There’re 7 keys on H83 at both sides of the phone screen 

that could be used as line keys and BLF keys. The eighth key is used for page switching. You may virtually switch 4 

pages so you’ll get 28 keys for line and BLF in total. 

By default the first 4 keys on the first “page” are line keys, if there’s only one extension configured on this H83 you 
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may not need any line keys to select lines you can configure the 28 keys as BLF keys. If you have configured 2 or 

more extensions on this H83 just configure the same number of line keys and other keys can be configured as BLF 

keys. 

 

In the above example, the H83 IP phone had line1 with extension 191 and line2 with 192 configured. The first 2 

DSS keys had been configured as line key. The third, fourth and fifth DSS keys had been configured as BLF keys and 

monitored 3 extensions’ status on line1. 

For more detailed configurations of the H83 IP phone DSS keys please refer to the IP phone user manual. 

 

Notice 

Besides ZYCOO IP phones, the PNP provisioning feature also supports Grandstream, Yealink, Escene, AkuVox, Htek, 

Cisco, MOCET, Fanvil and Snom IP phones. For these phones advanced configuration is not available. 

 

Phone Provisioning with Quick Register Code 

There’s no functionality page of Quick Register Code provisioning. If you want, the Quick Register Code could be 

exported in a MS excel file from the Telephony -> Extensions -> IP Extensions page by clicking on the 

 button. 

To ensure quick register code works please first disable PNP from the Telephony -> Extensions -> Phone 

Provisioning page. Then connect the ZYCOO CooFone H81/H81P and H83 IP phones to the same LAN as the IPPBX 

system. 

When the phone started up you’ll see on the phone screen “Auto Provision” notice displayed. 

 
H81/H81P quick register code provision screen 
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H83 quick register code provision screen 

 

Now you press View button and enter a Quick Register Code of a desired extension number and press Start. 

 

H81/H81P quick register code provision screen 

 

 

H83 quick register code provision screen 

 

Once Start pressed, it will go back to the default phone screen, and the phone will start to download 

configurations from the IPPBX system in the background, it will take 10 to 20 seconds, then the phones will reboot 

after rebooting the phones will then be configured and ready for phone calls. 

 

Notice 

Quick Register Code is only used to configure only one extension number on the CooFone H81/H81P and H83 IP 

phones. DSS keys are also unable to be configured. 
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Audio Library 

Music On Hold 

Path: Telephony -> Audio Library -> Music On Hold 

Music On Hold(MOH) is commonly known on an IPPBX system allows audio files (such as WAV or MP3 files) to be 

uploaded to the IPPBX system and played back when a caller is placed on hold or is waiting in a queue. 

Audio files are managed by folder basis. You may use the system default MOH folder as on hold music or you may 

create new folders and upload your custom music files. Please first click on “Create New Folder” to create a new 

MOH folder. 

 

Give this folder a name and set the playback mode as shuffle (random playback) or in turn (playback in order). 

One done click on “Submit”. 

Now click on  button to upload audio files to the newly created folder one by one. 

Supported File Format: MP3, WAV(8KHz, 16bit, Mono) 

 

Custom Prompts 

Path: Telephony -> Audio Library -> Other Custom Prompts 

Custom prompts are to be used by call queue, call forward and some other advanced features, where customized 

voice prompts required. 

You could record the voice prompts in MP3 or WAV (16bit, 8000Hz, mono) format and upload here. Then when 

you setup call queue periodic announcements you could select the customized voice prompts, or when you setup 

call forward notify message you could set the IPPBX system to notify callers before forwarding their calls. 
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Advanced Features 

Call Forward 

Path: Telephony -> Advanced Features -> Call Forward 

Call forward allows calls to an extension to be forwarded to a specific internal extension number or an external 

phone number.   

Before configuring call forward for user extensions, there are 2 advanced options you might want to know about.  

 
 By enabling Passthrough Caller ID option to cause the IPPBX system passing the actual caller ID to the target 

number while forwarding.  

 Notify Caller before Forwarding option allows you to choose a voice prompts to be played to the caller to 

notify caller this call will be forwarded. The voice prompts is uploaded from Telephony -> Audio Library -> 

Other Custom Prompts page. If this option is not enabled, the call will be forwarded without notifying the 

caller. 

To configure call forward please click on the  button. And follow the below explanations to complete the 

configurations. 

 

 In the Forward Extension dropdown list select the extension to be configured with call forward. 

 In Forward Type dropdown list select the condition of when to forward the incoming calls. 

 In the Number field specify the number to receive the forwarded phone calls. If it’s another internal 

extension number, just fill in with that extension number. If it’s an external number, you’ll have to specify the 

dial prefix in front of the actual number. In this case, the actual number is 65302387, the dial prefix is 9. 

 

In the forward list, you may disable or enable items based on requirements. 
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Call forward could be configured by Admin user and the operator user, and even by extension user from extension 

user web portal or by extension users from their phones by feature codes, please refer to Call Forward feature 

codes.  

 

Follow Me 

Path: Telephony -> Advanced Features -> Follow Me 

The Follow Me feature allows you to set a list of numbers for an extension number that the extension user may 

possibly be contacted on. Therefore, if someone calls the extension and the user is not available then follow me 

will work through the list calling each of the numbers in turn until the user is contacted or the list is exhausted. 

Before configuring follow me there are 2 advanced options you may want to know about. 

 
 Always Take Call: If enabled the forwarded call will be answered directly by a destination number, if disabled, 

when the forwarded call reached the destination number, IPPBX system will give the destination number 

choices to decline or answer the call. 

 Record Caller Name: Ask the caller to say his/her name and record the name, so it can be announced to each 

destination number. 

Add a follow me feature like below. 
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 Select the Extension which will be configured with follow me. 

 Ring Duration (Sec): Set the time in seconds to ring the extension before follow me process starts. 

 Follow Me List: The list of numbers to be reached in order. 

 Number and Timeout (Sec): The number to be reached and the time to ring this number before trying the 

next one. If the number is an external number don’t forget to add a dial prefix in front of it. 

Take the above settings as example, when extension 121 gets an incoming call, if it’s not answered in 30 seconds, 

the call will be forwarded firstly to 122 and ring this extension for 30 seconds, if still not answered, it will try 

number 65302387 (9 is the dial prefix, not part of the number) for another 30 seconds. If extension 122 answered 

the call then 65302387 will not be called. If the call didn’t answer by any of the numbers listed in Follow Me List, 

the follow me process will end and the caller will be disconnected. 

 

Wake Up Call 

Path: Telephony -> Advanced Features -> Wake Up Calls 

Wake up calls could be used to schedule reminders or wake up calls to the user extensions. Wake up calls could be 

scheduled by admin user from admin Web interface, by operator user from operator Web interface, or could be 

scheduled by extension users by dialing Wake Up Call feature codes. 

To schedule a wake up call from admin user Web interface, please click on  button, in the pop up window set 

the time of the wake up call and select the extension/extensions to be called at the scheduled time point. 

 

 Click on Date and Time field to schedule the date and time for the wakeup call. 

  
Click on Now to fill in the blank with the current date and time, and then you can modify as per your requirements. 
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Or you may choose a date and then click on Set Time to set the exact time of the scheduled wake up call. 

 

 In Extensions field you could select one or more extensions as you wish. 

 

When it’s time for wake up call, IPPBX system will ring the selected extension/extensions. After user answering the 

wakeup call, IPPBX system will give user options to “Confirm” wakeup call or to “Snooze”. If user press a key to 

confirm wakeup call then the schedule is completed, if user chooses to snooze, then the wakeup call will ring back 

later as per the user selected by key press.  

If a wakeup call is not answered, system will try to ring back in the next minute, and will retry 2 times, after this 

system will consider the wakeup call completed, and the schedule will be canceled. 

 

Conference 

Path: Telephony -> Advanced Features -> Conference 

Conferences allow two or more callers to be joined together so that all parties on the call can hear one another. 

Conferences are also referred as Conference Bridges or Conference Rooms. 

There are 10 conference numbers for internal extension users to dial to join conference calls. You can also set 

conference as a destination in inbound routes to allow outside callers to reach the conferences. 

 

There are totally 10 conference numbers could be used. Only users who dial the same conference number could 

hear one another. 

There are options for each conference for you to customize the conference feature. Please click the  button to 

change the options if needed. 
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 Guest Password is for ordinary conference users, only the users who enter the correct password can join in 

the conference.  

 Admin Password is for conference admin, only the user/users who enter the admin password will become 

the conference administrator. Conference admin can invite other numbers to join in the conference by using 

Conference feature codes. 

 Dial Permission could be used by the conference admin user to dial other numbers and invite them to join in 

the conference. By default, all conferences use Internal dial permission, which means by default the 

conference admin could only invite internal extension numbers to join in the conference, if inviting external 

number is necessary, please select a valid dial permission which could be used to dial external numbers. 

 Leader Wait, if enabled, the conference will start when the conference admin entered. Before conference 

admin joining in, all other participants will be waiting with background music. 

 Announce Callers option causes the IPPBX system to notify all conference participants about new 

participants join in. Before a new participant joining in the conference, the IPPBX system will ask the 

participant to say his/her name, once done, system playback the recorded name to other participants and at 

the same time, new participant joins in. 

 Call Recording option determines if the conferences to be held in this “conference room” should be recorded 

or not. 

 

Paging & Intercom 

Path: Telephony -> Advanced Features -> Paging & Intercom 

The Paging and Intercom feature allows you to use your phone system as an intercom system, provided that your 

endpoints (phone devices) support this functionality. The Paging and Intercom feature allows you to define an 

extension number that by calling the number will simultaneously page/intercom a group of phones.  

To create a Paging & Intercom group, please click on the  button, a popup window will show up as below 

screenshot. 
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 In the Group Number field, a default group number is given. The number could be changed within the Paging 

Group Extension Number Range listed on Telephony -> Preferences -> Global PBX Options page, Extension 

Ranges section. 

 In the Name field a name should be given to identify this paging group. 

 In the Mode dropdown list, if “Simplex” is selected, calling the group number will page on the group 

members, if “Duplex”, the group members are able to talk back to the caller (intercom). 

 In the Group Members field, select the desired user extensions, make sure all extensions you selected are 

desktop based IP phones, otherwise if the phone is an analog one, paging/intercom will not work. 

Except group paging and intercom, extension users could also paging/intercom an individual extension by using 

feature codes, please refer to introductions in Other feature codes section. 

 

Phonebook 

Path: Telephony -> Advanced Features -> Phonebook 

 

Phonebook feature for CooVox V2 series IPPBX is just like a contact list on the mobile phones. You may add 

contacts to the IPPBX system, when the contacts calling in, on the ringing user extension phone screen will display 

the caller number and the contact name you have added before. If the number didn’t match any contacts in the 

phonebook, then only caller number will be displayed on the ringing phone screen. 

You may click on the  button to add a new contact from the popup dialog.  
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Or you may export the phonebook template file to add the contacts by MS Excel and then upload the file to 

generate contacts. 

Contacts could be added by admin user from admin web interface, by operator from operator web interface and 

by extension user from extension user web portal. 

A contact added by admin user and operator user is visible to all extension users, but a contact added by an 

extension user is only visible to the user who added it and the admin and operator user, other extensions won’t be 

able to see it.  

 

Feature Codes 

Path: Telephony -> Feature Codes 

Feature codes can be dialed from user extensions to enable or disable certain features or to achieve some call 

features. For example, enable and disable call forward, transfer incoming calls, check voice messages, etc. 

 

Voicemail feature codes 

 

 

Dial *60 and you will enter the main menu of voicemail feature, by specifying the extension number and voicemail 

password of the required extension then you can check its voicemail and you can do this for any extension by 

following the system voice guidance. 

By dialing *61 from an extension and entering the voicemail password for this extension you can follow the voice 

guidance to check voicemail of your own extension. Or alternatively, you can configure some advanced options for 

your voicemail box. 

 

Call Pickup feature codes 

Call pickup feature codes allow users to pick up calls that are not directed to them by dialing a feature code *8 or 

**. 
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If there’s an incoming call ringing on an extension that belongs to your department, you may dial the general call 

pickup feature code *8 (end with #) to pick up the call. While if there are 2 ringing extensions in your department, 

by dialing *8 will pick up the first incoming call. If you need to pick up the second incoming call or if you don’t 

know which call came first, you may use direct call pickup feature code. 

Direct call pickup feature code could be used to pick up an incoming call on a specific extension, no matter the 

extension is from the same department or from another department. Just dial ** following by the extension 

number (end with #) you’ll be able to pick up the incoming call on that specific extension. 

  

Call Parking feature codes 

Call parking feature allows anyone who has received a call to park the call on an extension, allowing any other user 

to access the parked call. 

 

To park a call, extension user could dial *4 during a live call, and then listen as the system tells you where you can 

retrieve the call (usually extension 41). The second call will be parked on 42, and so on. 

To retrieve the parked calls, user should dial the retrieve number given by the IPPBX system. And this could be 

done by any extension. 

A call could be parked for maximally 120 seconds before it goes back to the extension which parked it. And the 

parking lot (call retrieve numbers) could be monitored by BLF. This is helpful if the operator wants to know if there 

are calls parked in the IPPBX system. 

 

Call Transfer feature codes 

Call Transfer is used to transfer a call in progress to some other destination. There are two types of call transfer. 

 Attended call transfer - Where the call is placed on hold, a call is placed to another party, and a conversation 

can take place privately before the caller on hold is connected to the new destination. It is also referred to as 

"Supervised Call Transfer". 

 Blind call transfer - Where the call is transferred to the other destinations without intervention (the other 

destination could ring out and may not be answered for instance). 

 

In a live call, you can press # key and the IPPBX system prompts “Transfer”, you then enter the number to transfer 
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to, this call will be transferred instantly and the user can hangup. If the transferred number doesn’t answer this 

call then it will go to voicemail. 

If blind transfer sometimes seems inappropriate, you may use attended transfer feature. In a live call, you can 

press *2 and the IPPBX system prompts “Transfer”, you then enter the number to transfer to, after someone 

answers your call, you can introduce this call and hangup at which point the call is transferred. 

In an attended transfer, if the third party rang for 15 seconds without answering, the extension user will go back to 

the caller and the transfer is terminated. You may also manually abort the transfer by pressing * when the third 

party is still ringing. 

 

Blacklist feature codes 

Black list feature codes allow the extension users to add external phone numbers to IPPBX system blacklist from 

their phones, consequently the numbers added will not be able to dial in to the IPPBX system.  

Adding blacklist numbers from phone by using feature codes is the same as adding blacklist numbers from admin 

and operator UI. 

 

Blacklist the last caller allows you to dial *76 to directly add the last caller’s number to the IPPBX blacklist. 

You may also dial *75 (end with #) and follow the voice prompts to specify the number you wish to blacklist to add 

numbers to the IPPBX system blacklist. 

To remove numbers from black list (whitelist a number), you can dial *075 (end with #) and follow the voice 

prompts to specify the number you wish to whitelist. 

 

Call Spy feature codes 

Call Spy allows users to dial the spy feature codes following by an extension number to listen to the call 

conversation in real-time. 

 

 Normal Spy: For example, extension 410 is talking to someone on the phone, you can dial *90410 (end with #) 

to listen to their conversation, however, neither speaker will be able to hear you. 

 Whisper Spy: Whisper spy is also known as coaching. For example, a new employee is talking to the customer 

on the phone, their supervisor can dial *91 following by the employee’s extension number (end with #) to 
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listen to their conversation. The supervisor can talk to the new employee only without the customer hearing 

the conversation. 

 Barge Spy: Barge spy is similar to an instant 3-way conference call. While an extension user is talking to 

someone else on the phone, you can dial *92 following by their extension number (end with #) to talk to 

both of the speakers. 

Notice 

Before you can spy on an extension, please enable “Call Spy” option from the extension edit screen. 

 

Call Queue feature codes 

Call queue feature codes are for call queue agent extensions only. They are meaningless to the non-agent 

extensions. 

 
Agent Login and Agent Logout are for dynamic agents to login or out the call queue. And for both static agents 

and dynamic agents, they can dial *95 to suspend their extensions temporarily, new calls will not be distributed to 

their extensions, until they dial *095 to resume. 

 

Conference feature codes 

Conference feature codes are used by conference admin for inviting participants to join in a conference or for 

creating a conference during a normal phone call. 

 
When in a conference room, if the conference admin user presses 0 they will get a dial tone for inviting others to 

participate in this conference. 

If the invited party agrees to join in the conference, conference admin user can dial ** to return to the conference 

with invited party. 

If the invited party doesn’t want to join in the conference, conference admin user can press *# to return to the 

conference without the invited party. 

During a live call the extension user can press *0 to create a dynamic conference room. The other side will 
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automatically enter the conference as an ordinary participant while the extension user who created this 

conference will be requested to enter the conference password to enter. Usually the user needs to enter the 

conference admin user password as the user needs to invite others to join in the conference. 

Notice 

After a dynamic conference is created, in reality you have entered a static conference room (by default 90 is the 

first available conference room). You are able to use conference admin menu to invite others to the conference 

also others can dial 90 to enter this conference. 

 

Wakeup call feature codes 

Except configuring wakeup calls from admin and operator web user interface, extension users could request 

wakeup calls from their phones directly by feature codes. 

 

 Cancel All Wakeup Calls: By dialing this code to cancel all requested wakeup calls. 

 Direct Wakeup Call Request: Add a wakeup call directly by dialing this feature code followed by a specific 

date and time in 8-digit number format, for example, feature code is *55*, you can dial *55*08010730 to add 

a wakeup call of 7:30am on August 1st. 

 Wakeup Call Main Menu: Advanced wakeup call menu for adding, viewing and canceling wakeup calls. 

Call Forward feature codes 

Call forward could be configured from admin and operator web user interface. With the following feature codes, 

extension users can activate or deactivate call forward directly from their phones without configuration on the 

Web GUI. 

 

For example, a CooVox IPPBX requires prefix 9 to call outbound, and the number you want to forward the calls to 
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is 85337096. 

 Forward All Activate: Dial *71985337096, press 1 to confirm. 

 Deactivate Forward All: Dial *071. 

 Activate Forward on Busy: Dial *72985337096, press 1 to confirm. 

 Deactivate Forward on Busy: Dial *072. 

 Activate Forward on No Answer: Dial *73985337096, press 1 to confirm. 

 Deactivate Forward on No Answer: Dial *073. 

 

DND feature codes 

DND (Do Not Disturb) could be set on the IP phones from the phone level, if the phone doesn’t have DND feature 

you may use the DND feature code to set DND from IPPBX system level. Any phone connected to the CooVox 

series IPPBX system can use the DND feature code, no matter if it’s IP phone, analog phone or softphone. 

 

Simply dial *74 to enable DND, if you hear a beep sound that means DND is on. Once DND enabled the extension 

will only be able to make calls, inbound calls will be rejected.  

Make sure when you are ready to receive inbound calls, dial *074 to deactivate DND.  

 

Other feature codes 

 

 Announce WAN Port IP: By dialing this code you'll hear the system announce the IP address of the IPPBX 

WAN interface.  

 Announce LAN Port IP: By dialing this code you'll hear the system announce the IP address of the IPPBX LAN 

interface. 

 Announce Extension Number: By dialing this code you can check the extension number of your phone, either 
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it’s an IP phone or analog phone. 

 One Touch Recording: One Touch Recording is also known as Record on Demand. It allows users to record 

phone calls selectively. In a live call conversation, an extension user can use feature code *1 to record this call. 

With this feature, you don’t have to configure recording all calls for the extensions which may cause heavy 

system resource use if some call recordings are not required. 

 Intercom: The intercom feature code allows you to intercom one extension only. You don’t have to create a 

“Paging and Intercom” group for only one extension if you intend to intercom with only that extension. 

 Paging: The paging feature code allows you to page one extension only. It’s the same as the intercom feature 

code, the only difference between paging feature code and intercom feature code is by using intercom 

feature code both sides can talk to each other but using paging feature code, only the caller can talk to the 

called party. 

 Audio Console: A speaker could be connected to the 3.5mm audio out (available on U60V2, U80 and U100V2) 

interface, extension user could dial *911 to deliver a public address from the audio out interface. 
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Reports 

Call Logs 

Path: Reports -> Call Log 

Call logs are also known as CDR (Call Detailed Records), on the call logs page you can check records for any call 

that went through the IPPBX system. 

To query call logs you need to first specify the search criteria. 

 

 In the Type dropdown list choose Outbound, Inbound or Internal to search outbound calls, inbound call or 

internal calls only. 

 In From and To fields set the start and end date to search call logs within this period of time. 

 By specifying the name of a trunk in the Trunk Name field to search the inbound or outbound calls came in or 

sent out through this specific trunk only. 

 In the PIN Code field specify a PIN code of a PIN Set to search outbound calls made by using this PIN code. 

The searching results might look like below. 

 

 The time when this call took place will be listed in the Start Time column. 

 In the Call From column lists the original caller of the calls. 

 In the Call To column lists the first callee but might not be the last. 

 The Final Callee column lists the extension/destination where the call finally ends. 

 In the Duration column lists the call duration of each phone calls, this might not be the exact talk time, as 

when calling though the FXO ports, IPPBX system will auto answer the inbound calls so IVR works, and it will 

auto answer the outbound calls, so the IPPBX could send the numbers out through the PSTN lines. 

 In the Trunk Name column lists the trunks used by those phone calls. Internal call will not take any trunk so 

this blank will be blank for internal calls. 

 In the PIN Code column, only those outbound calls made out with a PIN code will list the PIN code used here. 

This is a good idea to tell which user/users made the call, as the PIN codes are not shared by every extension 

user. Every extension may have a PIN different than others or several extension users share a PIN code that is 

different than others. 

 In the Type column it indicates the type of each phone call, inbound, outbound or internal. 

 In the Status column you could tell if the calls are successfully made or failed for any reason. 

 The Call Recording column indicates which calls are recorded and which ones are not. 

You may download the search results as a CSV file by clicking on the  button, or you may 

download all the call logs by clicking on . 
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Call Recordings 

Call Recordings 

Path: Reports -> Call Recordings -> Call Recordings 

Call recordings to be checked here are for those extensions which had enabled call recording from the extension 

edit page. 

Search criteria can be used to search call recordings are as follows. 

 

 Type could be used to search the call recording according to outbound, inbound and internal calls. 

 Call From could be used to search according to a specific callee’s number (optional). 

 Call To could be used to search according to a specific callee’s number (optional). 

 Trunk Name could be used to search according to the inbound/outbound trunk’s name (optional). 

 PIN Code could be used only for those calls which are dialed out with PIN codes define in PIN Set (optional). 

The searched recordings will be displayed in a list with some detailed information. 

 

You may playback the recording by built-in web player by clicking on the  button. 

 

Or you may click on the  button to download or click  to delete. 

Call recordings can be managed by both the admin user from admin web UI or by operator from the operator web 

UI. 

 

Conference Recordings 

Path: Reports -> Call Recordings -> Conference Recordings 

If the conferences had call recording enabled, the conference held will be recorded and conference recordings 

could be found for review here. 

 
In the Number dropdown list you may specify the conference number and search for recordings of the specific 

conference number only. 

The searched recordings will be listed with detailed information of when the conference calls were started, the 

conference number and the call/record durations. There are also the same options to playback, download and 

delete the recording files. 
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One Touch Recordings 

Path: Reports -> Call Recordings -> One Touch Recordings 

One touch recording is for those extensions that are not enabled call recording, when the user wants to record the 

call, by pressing *1 will start recording. 

The recordings of once touch recording could be found here. Search criteria and recording list options are the 

same as “normal” call recordings, except one touch recording could not be found on the Call Recording page. 

 

Fax Logs 

Path: Reports -> System Logging -> Fax Logs 

Fax logs stores all your inbound faxes and the outbound faxes sent from the extension user portal. 

The fax logs could be managed by both the Admin user and the Operator user. 

 

By downloading the .tif file to your operating system you may view the fax details. 

 


